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Preface
Introduction

Saluki vector signal generator products, frequency range covers 100 kHz to
3/6/12/20/22/40/44/50/67GHz, output power The range covers -110dBm to +15dBm,
phase noise -138dBc/Hz@1GHz, frequency offset 10kHz, with ultra-low phase noise and
spurious. Inside Internally generated baseband real-time modulation bandwidth up to
1GHz; external IQ input , the maximum modulation bandwidth can reach 2GHz.
Supports the generation of a variety of modulation signals , It has functions such as pre
-distortion calibration.

• Frequency range : 100kHz to 3/6/ 12/20/22/40/44/50/67GHz
• Outputpower range: -110dBm Upto+15dBm

• PhaseNoise：-138dBc/Hz@1GHz Frequency offset 10kHz

• Internal basebandmaximummodulation bandwidth : 1GHz
• External basebandmaximummodulation bandwidth : 2GHz
• Support digital modulation
• Support multi-tone signal
• Support multi-carrier digital modulation
• Support pulse radar
• Supports continuous wave radar
• Support Gaussian noise
• Support frequency hopping signal
• Support pre-distortion calibration and other functions
• Ultra-low phase noise and spurious
Models

1. VSG2003A Single Channel 3GHz Vector Signal Generator
2. VSG2006A Single Channel 6GHz Vector Signal Generator
3. VSG2012A Single Channel 12GHz Vector Signal Generator
4. VSG2020A Single Channel 20GHz Vector Signal Generator
5. VSG2022A Single Channel 22GHz Vector Signal Generator
6. VSG2040A Single Channel 40GHz Vector Signal Generator
7. VSG2044A Single Channel 44GHz Vector Signal Generator
8. VSG2050A Single Channel 50GHz Vector Signal Generator
9. VSG2067A Single Channel 67GHz Vector Signal Generator



2

Contents
Promise ................................................................................................................................................... 1

Precautions .................................................................................................................... 5

Front Panel Description ..................................................................................................9

Rear Panel Description ................................................................................................. 11

Get Started ...................................................................................................................12

Generate digital modulation signal .............................................................................. 13

Digital modulation parameter configuration ............................................................... 15

Frequency hopping signal parameter configuration .................................................... 18

Multi-tone signal parameter configuration .................................................................. 19

Multi-carrier parameter configuration ......................................................................... 22

Complex electromagnetic parameter configuration .................................................... 23

Noise signal parameter configuration .......................................................................... 24

Radar interface parameter configuration .................................................................... 25

IQ damage reduction parameter configuration ............................................................ 28

Scan parameter configuration ..................................................................................... 29

Pulsemodulation parameter configuration ................................................................. 31

RF bias parameter configuration .................................................................................. 33

ArbitraryWaveformMode .......................................................................................... 34

User playback file general IQ data ................................................................................ 34

User plays IQ sequence data .........................................................................................35



2

Precautions

The following are all the operating procedures of the instrument: , safety
precautions to be observed. To avoid damage to the instrument and unnecessary
bother Please read all the contents of the precautions patiently. The product manual
is provided to users in the form of USB storage or printing.

The user is required to use the instrument only for its intended use and within its
performance limitations. The intended use and limitations are stated in the
instrument documentation. describe , as shown in the manual , printed safety
instructions. If you are unsure whether there is proper use , please contact Saluki
service department ,if Any part of the instrument is damaged or broken Please stop
using the instrument. , do not open the instrument casing,Only Saluki service staff can
maintain Repair the instrument.

Heat dissipation conditions
Place the instrument on a cart or workbench, paying attention to the spacing

requirements:
Top and bottom :0 centimeter( 0 inch)
Left and right sides :5.08 centimeter( 2 inch)
later :0 centimeter( 0 inch)

Environmental conditions
This instrument is generally used in a laboratory environment If the user has field

testing requirements , the product shell is not waterproof , waterproof protection is
needed. If the device is accidentally flooded , the water that enters will connect the
housing to the electrical parts , which may damage the device If the user comes into
contact with shell , which may cause electric shock, causing personal injury. Users can
use the instrument at an altitude of 2000 meters . Try to avoid placing the instrument
in severe In polluted environments, such as dust , smog pollution. For more
information on environmental conditions such as ambient temperature and humidity ,
see Environmental Suitability Planning guarantee.

The following table lists the environmental requirements for your instrument. To
achieve instrument accuracy, make sure to warm up the instrument. 20 minutes and
meet the following conditions Environmental requirements.
Require illustrate
Temperature(Working
state)

0℃ to 50℃

Humidity(Working state) 5% to 90% relative humidity
5% to 45% relative humidity

,
,

No higher than 30℃
30℃ to 50℃ non-condensing

Altitude (Working Status) Up to 2,000 m

Connecting to the Power Supply
The instrument needs to be connected to a fixed power source for power supply.

Caution Electronic products have risks , if electric shock occurs, it may cause fire.
Causing personal injury or even death. The instrument operating voltage range is 90V
AC to 264V AC , 45 to 65Hz , to reduce the risk of fire and electric shock ,please Ensure
that the voltage fluctuation of the mains power supply does not exceed the working
voltage range 10%.

To ensure your safety , please take the following measures:
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1) Before turning on the instrument, make sure that the voltage and frequency
indicated on the instrument match the available power supply. all , please set the
correct value;

2) It is recommended that users only use the power cable delivered with the
instrument. It complies with country-specific safety requirements;

3) It is recommended that users only insert the plug into a socket with a protective
conductor terminal ;

4) Users are advised to use only complete cables.

Instrument handling
The weight specification of the instrument is ≤ 30kg. For your safety, please try

not to move or carry the product by yourself . Place the device in a safe and suitable
place , if the instrument must be moved, it can be used For your safety , please use
convenient transport when moving the instrument tool , such as a trolley, etc., please
follow these instructions whenmoving.

Instrument placement
When placing the instrument, always place it on a stable , flat surface with the

instrument bottom facing down. If the instrument is aimed at a different position,
Protect the instrument from falling. If the instrument has foldable feet , always fully
fold the feet in or out to ensure stability. Fold completely , or the instrument is moved
without being lifted, the feet will collapse. The foldable feet are designed to carry the
weight of the instrument, but Not an additional load. If you need to stack the
instruments , please remember , a pile of instruments could fall over and cause injury.
The device is installed in the rack , make sure the rack has adequate load capacity and
stability. Follow the rack manufacturer's specifications. Always mount the instrument
from the bottom to the top to make the rack secure. Secure the instrument so it
does not fall off.

A pile of products may fall over and cause injury. Do not stack more than three
products on top of each other. , install them in a rack. Note the following:

1) It is best if all products are the same size (width and length);
2) The total minimum product load shall not exceed 500 N;
3) If the smaller product is on top of the lowest product , the total load of the

minimum product shall not exceed 250 N.
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Equipment transportation
If the instrument needs to be transported, please use the packaging materials

that our company sent it with. Using packaging materials other than the specified
packaging materials may cause damage to the instrument. Do not use styrene
microspheres of any shape as packaging materials. They will not adequately cushion
the instrument or prevent the instrument from moving in the carton. And can Can
generate static electricity and stay on the instrument shutter , blocking the airflow and
causing equipment damage.

Our instruments are equipped with protective caps on the front panel connectors
when they leave the factory. , to prevent impact damage during shipping. When
returning the instrument for repair ,like Cable required , please remove the cables and
place them in a separate protective bag.

Safety SignMeaning
Safety labels on the instrument warn of potential hazards. Please read the
instrument's software manual. to avoid personal injury or The device is
damaged.

Heavy equipment in transportBe careful when moving or carrying the
instrument. At least two people or transport equipment are required to carry
the instrument.

Electrical hazard indicates live parts, which may cause electric shock., Fire,
personal injury, or even death.

Hotter surface , do not touch. Risk of skin burns , the risk of fire.

Grounding hole. When using the instrument, you need to ground it through
the grounding hole or wear an anti-static wrist strap. If an electrical
problem occurs , It can prevent electric shock.
Universal recycling logo. This logo indicates compliance with the Chinese
standard GB required by China RoHS regulations on paper/ fiberboard
packaging
18455-2001.

This symbol indicates that the required input power is AC.

This mark indicates that the chassis is grounded.
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Get Started

Turn on the instrument power

1. Connect the AC power cord to the rear of the instrument.

2. Turn on the instrument using the front panel power button.

Power The (Power) button indicates the three power states of the instrument:

1. Not bright - No power

2. Red - Standbymode

3. Fluorescent green - Power on
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Front Panel Description
Front panel connectors

Connectors describe
Analog Output These connectors provide analog signals.

VSG2003A 3.5 mm -K Panel Connectors
VSG2006A 3.5 mm -K Panel Connectors
VSG2012A 3.5 mm -K Panel Connectors
VSG2020A 3.5 mm -K Panel Connectors
VSG2022A 3.5 mm -K Panel Connectors
VSG2040A 2.92 mm -K Panel Connectors
VSG2044A 2.92 mm -K Panel Connectors
VSG2050A 2.4 mm -K Panel Connectors
VSG2067A 1.85 mm -K Panel Connectors

USB 2.0 Three USB Host connector ( Type A ) for connecting
a mouse, keyboard or other USB equipment



2

Front Panel Controls

Buttons/Keys describe
FREQ (Frequency) Setting the output frequency
LEVEL (Power) Setting the output power
Knobs The general purpose knob is used to increment or

decrement the value when the setting is enabled
(selected) for change.

Numeric Keypad The numeric keypad is used to enter numeric
values directly into the selected control setting.
Unit prefix buttons ( G/n , M/ μ, andk/m ) is used to fill
in input via the numeric keypad. You can press one of
the prefix buttons to complete the entry ( without
pressing the Enter key ) .
If the unit prefix button for frequency is pressed ,

the unit is interpreted as G ( Ji ) 、 M ( Mega ) or k (

thousand ) .
If the TimeorAmplitudebutton is pressed , theunits are
interpretedasp ( pico ) , n ( nano ) , μ ( micro ) orm ( milli
meter ) .

RF ON / OFF (RF switch) Used to switch the RF output status: on or off
MOD ON / OFF (Modulation
switch)

Used to switch the modulation output status:
open or closed

LOCAL (Local Control) Switch to local control mode
SETUP​
HELP​
PRESET​ Used to restore the instrument to default settings
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Rear Panel Description
Rear Panel Connectors

Connectors describe
10 MHzReference input SMA Type connector for providing reference signal
10 MHzReference output SMA Type connector for providing reference signal
Trigger input ( TRIG IN） BNC Type input connector for receiving external trigger

signals
Synchronous output ( SYNC
OUT）

BNC Type input connector for providing synchronization
signals to external devices

Pulse output signal ( PULSE
OUT）

BNC Type input connector, used to provide pulse signals
to external devices

Pulse input signal ( PULSE IN
）

BNC Type input connector, used to receive external
pulse signal

INT BB-OUT BNC Type input connector for providing differential analog
I, QSignal

EXT BB - IN BNC Type input connector for receiving external
differential analog I, QSignal

LAN RJ -45 connector is used to connect the instrument to the
network

USB Three USB Host connector ( Type A ) for connecting a
mouse, keyboard or other USB equipment

VGA VGA The video port is used to connect an external
monitor to view a more detailed view of the
instrument display . Large copy ( duplicate ) or
expand to desktop monitor.

HDMI The HDMI video port is used to connect an external
monitor to view a more detailed view of the
instrument display . Large copy ( duplicate ) or
expand to desktop monitor.

GPIB Connector for remote operation of the instrument
DEBUG Test port (not open to the public)
Grounding column M6Grounding column
power supply Power line input
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Get Started
Generates unmodulated signal

1. On the front panel of the VSG20 vector signal generator , click “PERSET” to
restore the instrument to factory settings;

2. Set the frequency:
a. Click “FREQ” on the front panel or click “Block Diagram > Frequency” on the

touch screen. Use the numeric keypad to input "1", "0" and "GHz"
b. The frequency can also be set by using the direction keys or knob to select the

corresponding setting position
3. Set the power:
a. Click "LEVEL" on the front panel or click "Block Diagram > Level" on the panel

touch screen. After the screen window is highlighted , Use the keyboard to input "1",
"0" and "dBm"

b. The frequency can also be set by using the direction keys or knob to select the
corresponding setting position

4. Click "Block Diagram > RF Status Bar > RF ON" on the touch screen to turn on
the RF output. , or you can turn it on via the “RF ON/OFF” button on the front panel
RF output;

5. The RF signal will be output through the RF connector on the front panel.
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Generate digital modulation signal

1. On the front panel of the VSG20 vector signal generator , click “PERSET” to
restore the instrument to factory settings;

2. Set the frequency :
c. Click “FREQ” on the front panel or click “Block Diagram > Frequency” on the

touch screen. Use the numeric keypad to input "1", "0" and "GHz"
d. The frequency can also be set by using the direction keys or knob to select the

corresponding setting position
3. Set the power :
c. Click “LEVEL” on the front panel or click “Block Diagram > Level” on the panel

touch screen. After the screen window is highlighted, Use the keyboard to input "1",
"0" and "dBm"
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d. The frequency can also be set by using the direction keys or knob to select the
corresponding setting position

4 ． On the touch screen, tap “Baseband bar>Digital Mod " jumps to the digital
modulation parameter configuration interface

5. Set digital modulation parameters via touch screen or external USB mouse

Symbol Rate ：100Msym/s

Coding: Nature
Modulation Type:QPSK
Data Source:PRBS12

Filter：Root Raised Cosine

Alpha/BT : 0.22

6 ． Click "Generate" in the upper left corner of the interface , the software will
automatically turn on the modulation switch
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Digital modulation parameter configuration

Digital modulation supports: PSK (Phase Modulation), QAM (Quadrature
Amplitude Modulation ), MSK (Minimum Shift Keying), FSK (Frequency Shift Keying),
APSK (Amplitude Modulation), Phase Shift Keying)

Phase modulation support ：BPSK(bipolar code), π /2 BPSK (bipolar code), Q PSK
(Quadrature Phase Shift Keying) , π /4 QPSK (Quadrature Phase Shift Keying control),
π /2 QPSK (Quadrature Phase Shift Keying)

Quadrature Amplitude Modulation Support : 4-QAM, 8-QAM, 16-QA M, 32-QAM
and 64-QAM

Minimum frequency shift support: Yes MSK (Minimum Shift Keying) , GMS K
(Gaussian Minimum Shift Keying), CPM (Continuous Phase Modulation)

Frequency shift keying support: 2-FSK , 4-FSK , 8-F SK , 16-FSK , 32-FSK
Phase shift keying support: including 16-APSK , 32-APSK , 64-APSK , 128-APSK ,

256-APSK
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Filter Type Support ：raised cosine , rooted raised cosine, rectangle (rectangular
window), Gaussian (Gaussian filter) , half-sine (half-band filtering) , user- defined
filter coefficients

User-defined filter coefficients are time domain coefficients , for example 0 , 0 , 1
, 1 , 0 , 0 can produce a rectangular window filter, corresponding to the frequency
domain is sinc function.

Alpha/BT (filter roll-off factor ):
The value range is 0.00~1.00, and the default value is 0.22. , the larger the roll-

off factor, the slower the filter passband edge decays. The factor characterizes the
excess bandwidth relative to an ideal rectangular filter, Therefore, the actual signal
bandwidth = symbol rate * ( 1 + roll-off factor ) , bit error Rate theory is not affected.

The minimum symbol rate supported is 1Hz , maximum according to option ,
which can support up to 200MHz or 500MHz.

Baseband data can support all 0s and all 1s ,
PN7/PN9/PN11/PN12/PN15/PN16/PN20/PN21/PN23 , custom files. The PN code is
generated by a linear shift register to be fed back. , as shown below:
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Frequency hopping signal parameter configuration

The frequency hopping signal generation mode is divided into pseudo-random
sequence and user list mode. The pseudo-random sequence can realize pseudo-
random frequency hopping according to the pattern type based on the number of
frequencies. The user list mode starts from the first frequency and performs
frequency hopping in sequence according to the multiple frequencies selected by
the user. With this Back and forth.
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Multi-tone signal parameter configuration

The multi-tone signal generation interface can generate multi-tone signals in the
Nyquist frequency range corresponding to the current sampling rate. , users can set
the list parameters The frequency of the number generated in the list , set the tone
Number (number of polyphonic sounds) After the change , the list will change
synchronously , Freq The Distance parameter can adjust the frequency interval
between newly generated frequencies .

Notice : The frequency range of the generated multi-tone signal must conform to
the Nyquist sampling bandwidth.
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Analog modulation parameter configuration

Analog Modulation , Modulation mode support: AM (amplitude modulation),
DSB_SC (double sideband modulation), SSB_U (upper sideband modulation) , SSB_L
(lower sideband modulation) , PM (Phase Modulation) , FM (Frequency Modulation)
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Modulation waveforms supported: sine (sine wave), square (square wave),
triangle (triangle wave), sawtooth sawtooth wave and inv.sawtooth
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Multi-carrier parameter configuration

Multi-carrier modulation supports generating different digital modulation signals
at different frequency offsets of the carrier . The size of the frequency offset
depends on option Options , which can support up to 200MHz or 500MHz.
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Complex electromagnetic parameter configuration

Complex Electromagnetic , which can generate digital modulation at different
frequency offsets of the carrier at the same time , multi-tone and frequency hopping
signals. For parameter settings, please refer to Digital Tuning Control parameter
configuration , frequency hopping signal parameter configuration and multi-tone
signal parameter configuration.
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Noise signal parameter configuration

Noise generation mode can generate Gaussian white noise , the generated noise
bandwidth can be adjusted.
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Radar interface parameter configuration

Radar modulation mode: PRI stands for Pulse Repetition Interval (Pulse Period ) ,
The pulse width setting should be smaller than the pulse period. , in the setting
Generate Pulse within BandWidth (bandwidth) Number ( pulse number) pulse signal.

Radar modes include: Linear FM (Linear Frequency Modulation) , rectangular
(rectangular wave) , phase coded , FMCW (tuning Frequency Continuous Wave),
Stepped FM (Step Frequency Modulation) , NLFM (non-linear frequency modulation).
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PRI modulation support : Constant ; Sliding​ ; Stagger​ ; Triangle（ triangle );
Sine Sine ); Jittered
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Scan direction support ： up (frequency sweep upward) , down (frequency
downward scanning) and tr iangle (rectangular wave scanning) modes

Scan interval support : positive (positive frequency interval) and symmetric
(symmetric interval)
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IQ damage reduction parameter configuration

There are IQ impairment configurations on the right side of the digital
modulation mode, analog modulation mode, multi-tone signal, frequency hopping
signal, radar signal, and noise signal interfaces: Can be used to configure IQ two-way
power distribution, phase imbalance, Clock skew , frequency offset , DC bias and
signal-to-noise ratio.
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Scan parameter configuration

Scanning is divided into frequency scanning and power scanning , combined scan
and list scan. When the scan mode is turned on , the frequency and power set on
the main interface Not effective.

Linear frequency sweep mode: starting from the start frequency and ending at
the cutoff frequency, one frequency point is scanned every other step frequency ( st
artFreq + stepLinear), the time difference between adjacent frequency points is the
dwell time.

Among them: the difference between the start frequency and the cut-off
frequency is the sweep bandwidth span, and the frequency between the start
frequency and the cut-off frequency is the center frequency ; if Starting frequency
change , then the cutoff frequency remains unchanged , the sweep bandwidth and
center frequency change accordingly , if the sweep bandwidth is changed, The
center frequency remains unchanged. The start and end frequencies change.
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Notice: The linear sweep mode can only be used when generating an
unmodulated signal.
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Pulse modulation parameter configuration

Pulse modulation mode can generate pulse modulation signals , divided into
pulse modulation and pulse generation, the pulse modulation module has internal
and external pulse trigger options Selection and pulse synchronization delay
function; in the pulse generation module: the pulse width setting should be smaller
than the pulse period If the pulse width is set greater than the pulse period The
software will then roll back the settings.

There are two types of pulse channels: internal and external

The pulse mode has two modes: pulse synchronous trigger and pulse delay
trigger.
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Trigger has automatic trigger and external rising edge trigger
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RF bias parameter configuration

RF bias parameter configuration can be used for frequency , power and phase
settings with different bias For example ：Actual output frequency = main interface
frequency + bias frequency
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Arbitrary Waveform Mode



34

User playback file normal IQ

The data file is saved in binary format and contains only IQ data, which are saved
as 16-bit signed integers. The data comes after. For example, you can use the
following matlab code to store the complex data userData generated by the user:

iq = zeros( 1, 2*length( userData) );
iq(1:2:end) = real(userData);
iq(2:2:end) = image(userDat a);
fidIQ = fopen('test.bin', 'wb' );

fwrite( fidIQ , iq , ' int 16 ' );

fclose(fidIQ);
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User plays IQ sequence data

The data file consists of 2 modules:
The first part is the parameter configuration area, which stores the number of

segments N , the length of each segment and the reserved fields;
The second part is the binary IQ data area.

For example, open the data file userdata1.bin , you can see the following content
(the number on the far left is the line number displayed by the text editing software,
Non-file content ):

The first line N 10, indicating a total of N=10 segments;
The second line is always a blank line;
From the third to the twenty-second line , a total of 20 lines, corresponding to

the length and parameter information of 10 segments. For example, the third line
shows Len1 50000, table The first segment length is 50,000 complex samples ( I+jQ
） The fourth line shows that T1 1 is a reserved field. , meaningless.

The 2nd*N+3rd line is a blank line, used as a separator , meaningless .

Starting from line 24 , which is the binary data area , continuously store 10
segments of IQ data , are 1- bit and 6-bit signed integers respectively. , I data

in front , Q data comes after.
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Sequence File

Click New After List, a sequence configuration file will be created. Select the save
location to save the newly created sequence configuration:

Click Load List The sequence configuration file will be called later The
configuration information contains the following list:
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Clicking Save List will save the sequence configuration file;
Click OutPut File and it will be merged

Concatenate the sequences in the list into a binary data file and choose the save
location:
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Table Configuration Page

Click Append and a pop-up window will pop up to select a binary data to import:

After successful import:

Click Delete to delete one of the sequence files.
Clicking shift Up will move the current sequence up:
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Clicking shift down will move the current sequence down
Clicking Append Blank will add a blank data series:

Sampling Rate and Power Configuration Page

Sampling rate configuration mode:
1. Select Unchanged: Do not oversample the sequence file , play at original rate
2. Select Highest: The sampling rate of the sequence with the highest sampling

rate will be used as the basis , other sequences are oversampled to their values



40

3. Select User Defined: The sampling rate will be based on the user's customized
sampling rate. , other sequences are oversampled to their values

Power settings:

1. Select Unchanged: Do not perform power normalization on the original
sequence file

2. Select Equal RMS: Unify the RMS of all sequence files to the same value for
playback

Trigger configuration:

Current Segment displays the current trigger file
Current Segment Index Displays the current trigger segment index Segment: Set

the current index of the trigger
Next Segment Mode:
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1.Same Segment: The number of segments triggered next time is the same
2.Next Segment: The segment number of the next trigger is the next segment

number of the current segment number
3. Next Segment Seamless : The segment number of the next trigger is the next

segment number of the current segment number (phase continuous, available in
non-oversampling mode )

4.Squencer: The number of segments of the entire sequence table that will be
triggered next time

Select internal or external trigger:

1. Internal: Internal trigger
2. External Global Next Segment: External Trigger

3. After selecting internal trigger Click Execute Next Segment to generate an
internal trigger event.
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Graphical configuration interface

Select the system configuration on the interface by touching the screen or using
the arrow keys, and find the Graphics Configuration option. , open the graphics
options ,Can Generates a simulated graph of the signal according to the set
parameters , which can generate a spectrum diagram , Constellation Map , IQ plots,
and complementary cumulative distribution plots.
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Device information query
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The Info interface can query the software version information and option
information of the current device.
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IP address configuration

Select System Configuration on the interface and find IP Address Configuration
to view the IP address. , gateway and subnet mask, etc., press the ESC button You
can exit the operation interface.

The remote port is :5025
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Internal and external reference configuration

Select System Configuration on the interface and find the internal and external
reference settings , you can set the internal reference and external reference switch ,
frequency accuracy adjustment. Select ExternalI/Q can set the internal and external
trigger mode of I/Q , press the ESC button to exit the operation interface.
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Programming Instructions
When connected to an external controller , you can use the Ethernet interface to

connect to perform automatic measurements on the instrument. In addition,
remote control commands The SCPI standard , which is known as the global
standard, is adopted. , see SCPI 1999.0 ( SCPI Consortium).

The general conditions for using the SCPI standard are as follows:
1. Ethernet commands are standardized.
2. The general settings on the system toolbar (for example: setting the time) are

not supported , date) and file browsing (e.g. viewing a list of files).
3. All the above conditions can be read through commands.

Network connection

This section describes the connection of devices using the remote control
function and the setup using the Ethernet interface.

The remote control function of the instrument is realized by remotely controlling
the instrument from a remote control PC. Use 100M, 1 000M Ethernet interface
Connect the instrument to the remote control PC The default working ports are 50
and 25. The example is shown in the figure below.

It is recommended to connect , do not use a HUB but connect directly. When connecting
directly, it is recommended to use a crossover cable ( cable).

Device Messages

Device messages are data messages transmitted and received between the
controller and the device through the system interface. Device messages include
program messages and response messages. A program message is an ASCII data
message transmitted from the controller to the device. A response message is a data
message transmitted from the device to the controller.

Program messages and response messages have the following types:
Program Messages
(See Write Command Example)

Response Message
(See Read Command Example)

Program instructions
• Device Specific Commands
(See “SCPI Commands”.)
• IEEE 488.2 Common Commands
(See "IEEE 488.2 Common
Commands".)

Program Query
• Response message
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SCPI Command Format
ProgramMessages

This section describes the format of the instrument's program messages sent
from the sender (remote control PC) to the listener (instrument). Comply with SCPI
standards, Therefore, SCPI commands are used in the examples in this section.

Program messages are composed of a series of functional elements, which are
the smallest units of functions and are enclosed in <>. Program Message> is a
functional element.

A <complete program message> is composed of a <program message> and a
<program message terminator>.

<Program Message> Combination of one or more <Unit Program Messages >.
When there are multiple <Unit Program Messages> , you need to use < Separator >
to separate.

The instrument detects the end of program message character ( NL) to receive
program messages. The functional elements of program messages are described
below.

Program message terminator ( NL) is defined as a single ASCII code byte 0A
(decimal 10 ) , which is the ASCII control character LF (replace line character).

<Space> is defined as a single ASCII byte in the range 00 to 09, 0B to 20 (0 to 9, 0
to 20 decimal). 11 to 32). This range includes ASCII control characters and space
signals except line feed characters , which the instrument simply treats as Spaces or
ignore them , without interpreting them as ASCII control characters.
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ResponseMessage
This section describes the information that the instrument (transmitter) sends

back to the remote computer ( Listener) The format of the response message.
The following diagram shows the SSC switch status query command:

"SOUR:JITT:SSC:ENAB?" and the SSC type query command. ": SOUR : JITT : SSC : TYPE
?"

Write command example
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Read command example

Remote desktop

Use a personal computer to control the instrument through Ethernet using
Windows Remote Desktop. If the personal computer screen is larger, it is more
convenient to view detailed information.

In the remote desktop connection interface, enter the IP address of the
controlled instrument and click Connect. Before connecting, please make sure that
the local IP and the controlled instrument IP are in the same One network segment.
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Command control

1. COMMON Command
Common commands are specified by the IEEE488.2 standard. , starting with 9*I ,
composed of 3 letters

*IDN?
Query instrument information.
Return value:
<ID> returns 4 fields separated by 9,9 , the fields have the followingmeanings:

Manufacturer ,model , serial number,Firmware version number
Example:

ISinoIink TechnoIogies,VSG,abcd12,2 .0.2.0I

*OPC?
Check whether the operation is completed

*RST
Reset, resets the vector source to the default state.
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2. OUTPut Subsystem
In the output subsystem , the user can configure the output of the signal, For
example, on/off status In the output subsystem , SCPI has a common prefix
"OUTPut:"

:OUTPut<hw>[:STATe] <State>
Activate the RF output signal of this channel of the instrument.
Parameters :
<State> 1 | ON | 0 | OF​

* RST :0
Example :

:OUTPut:STATe
OFF closure RF

:OUTPut:ALL[:STATe] <State>
Activates all RF output signals of the instrument.
Parameters :
<State> 1 | ON | 0 | OF​

* RST :0
Example :

:OUTPut:ALL:STATe
OFF Turn off all RF
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3. SOURce subsystem
The Source subsystem contains the SCPI commands for configuring the signals.

[:SOURce<hw>]:SELect <Mode>

Open the
corresponding
mode
interface
Parameters :
<Mode > DM| ARB | RADar | OFDM | MCCW| ANALog | HOP | NOIS | PULM |
Complex |
MCar
Example :

Source1:SELect DM
Select channel A digital modulation mode
Source 2: SELect ARB
Select Channel B User File Mode

DM Digital Modulation
ARB User file playback
RADar radar
OFDM OFDM
MCCW Multi-Carrier CW
ANALog Analog Modulation
HOP Frequency Hopping
NOIS noise
PULM Analog Pulse Modulation
Complex Complex electromagnetic environment
MCar Multi-Carrier

[:SOURce<hw>]:IQ:STATe <Stat e>
Switch IQ MOD switch.
Parameters :
<State> 1 | ON | 0 | OFF

* RST :0
Example :

SOURce1:IQ:STAT
e 0 closure IQ
MOD

[:SOURce<hw>]:FREQuency:FREQuency <Fixed>
Set the frequency of the RF output signal (display frequency, including offset).
Parameters :
<Fixed> float
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Value range: RFmin to RFmax
*RST: profile

Example :
SOURce 1: FREQuency : FREQuency
6000000000 Set the output frequency
to 6GHz

[:SOURce<hw>]:FREQuency[:CW|FIXed] <Fixed>
Set the frequency of the RF output signal (actual frequency, excluding offset).
Parameters :
<Fixed> float

Value range: RFmin to RFmax
*RST: profile

Example :
SOURce 1: FREQuency 6000000000

[:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude]
Set the amplitude of the RF output connector (display amplitude, including offset).
Parameters :
<Power> float

Value range: Powermin to Powermax
*RST: profile

Example :
SOURce1:POWer 15

[:SOURce<hw>]:POWer:POWer <Power>
Set the amplitude of the RF output connector (actual amplitude, excluding offset).
Parameters :
<Power> float

Value range: Powermin to Powermax
*RST: profile

Example :
SOURce1:POWer:POWer 15

3.1 SOURce:BB:IMPairment Subsystem
[:SOURce]:BB:IMPairment:RF<ch>:IQRatio[: MAGNitude] <IqRatio>
Sets IQ gain imbalance.
Parameters :
<IqRatio> float

Value range : -100 to 100
* RST : 0
Default unit: dB

Example:
SOURce:BB:IMPairment:RF:IQRatio:MAGNitu de 10
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[:SOURce]:BB:IMPairment:RF<ch>: QUADrature[:ANGLe] <Angle>
Sets the IQ phase imbalance.
Parameters :
<Angle> float

Value range : -180 to 180
* RST : 0
Default units: DEG

Example:
SOURce:BB:IMPairment:RF:QUADrature -5

[:SOURce]:BB:IMPairmen t:RF<ch>:SKEW <Skew>
Set the time offset between IQ.
Parameters :
<Skew> float

Value range: -100 to 100
Stepping: 1E-12
Default unit: s
* RST : 0

Example:
SOURce:BB:IMPairment: RF:SKEW -5

[:SOURce]:BB:IMPairment:RF<ch>:SNR <Snr>
Set the signal-to-noise ratio.
Parameters :
<Snr> float

Value range: -1000 to 1000
Default unit: dB
*RST: 1000

Example:
SOURce:BB:IMPairment:RF:SNR -5

3.2 SOURce:BB:DM Subsystem
[:SOURce<hw>]:BB:DM:STATe <State>
Enable/disable digital modulation.
Parameters :
<State> 1 | ON | 0 | OFF

* RST : 0
Example :

SOURce:BB:DM:STATe ON
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[:SOURce<hw>]:BB:DM:FORMat <Format>
Select the modulation type.
Parameters :
< Format > BPSK|P2BP|QPS K|APSK16|OQPS|3P8P8|P2QP etc.

*RST: QPSK
Example :

:BB:DM:FORMat BPSK

PSK QAM MSK APSK PAM
BPSK QAM4 MSK APSK16 PAM4
P2BPsk QAM8 GMSK APSK32 PAM8
QPSK QAM16 CPM APSK64 PAM16
P4QPsk QAM32 APSK128
P2QPsk QAM64 FSK APSK 256 ASK
OQPSk QAM128 FSK2 APSK16D23 ASK
SOQPsk QAM256 FSK4 APSK16D34 ALSO
UQPSk QAM512 FSK8 APSK16D45
PSK8 QAM1024 FSK16 APSK16D56
P2P8 QAM2048 FSK32 APSK16D89
3P8P8 QAM4096 APSK16D90
OPSK8 QAM8192 APSK32D34
PSK16 QAM16384 APSK32D45
P2DBpsk APSK32D56
DQPSk APSK32D89
P4DQpsk APSK32D90
D8PSK
D16PSK

[:SOURce<hw>]:BB:DM:CODi ng <CODing>
Select an encoding.
Parameters :
< Format > NATUre|GRAY

*RST: NATUre
Example :

:BB:DM:CODing GRAY

[:SOURce<hw>]:BB:DM:CODi ng <CODing>
Select an encoding.
Parameters :
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< Format >
NATUre | GRAY
*RST: NATUre

Example:
:BB:DM:CODing GRAY

[:SOURce<hw>]:BB:DM:FILTer:FORMAT <Type>
Select the baseband filter type.
Parameters :
<Type> RCOSine | COSine | GAUSs | RECT | NONE | HALF | SOQT | SOQA | SOQB

*RST: RCOSine
Example:

:BB:DM:FILTer:FORMAT RCOSine

[:SOURce<hw>]:BB:DM:PRBS <Type>
Sets the length of the pseudo-random sequence.
Parameters :
<Type> ALLZero | ALLOne | PATTern | 7 | 9 | 11 | 12 | 15 | 16 | 20 | 21 | SOQB

*RST: profile
Example:

:BB:DM:FILTer:PRBS 7

[:SOURce<hw>]:BB:DM:FILTer:PARameter:COSine[:ROLLoff] <Cosine>
[:SOURce<hw>]:BB:DM:FILTer:PARameter:GAUSs <Gauss>
[:SOURce<hw>]:BB:DM:FILTer:PARameter:RCOSine <RCosine>

设置滤波器参数.

Example:
SOURce:BB:DM:FILTer:PARameter:RCOSine 0.5

[:SOURce<hw>]:BB:DM:SRATe <SRate>
Set digital modulation symbol rate. Units sym/s/ksym/s/Msym /s.
Parameters :
<SRate> float

Value range: 50 to options
Stepping: 1E-3
Default unit: sym/s
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Example :
SOURce:BB:DM:SRATe 50 ksym/s

[:SOURce<hw>]:BB:DM:ASK:DEPTh <Depth>
Sets the modulation depth for ASK type modulation.
Parameters :
<Depth> float

Value range: 0.1 to 1
Step: 0.01
* RST : 0.1

Example :
BB:DM:ASK:DEPT 0.5

[:SOURce<hw>]:BB:DM:FSK:DEViation <Deviation>
Set the frequency deviation for FSK type modulation.
Parameters :
<Depth> float

Value range: 1 to 80e6
*RST: 1e3

Example :
SOURce:BB:DM:FSK:DEViation 1MHZ

3.3 SOURce:BB:ARBitrary Subsystem
[:SOURce<hw>]:BB:ARBitrary:STATe <State>
Play/stop user file single segment mode. (Can only play when wave file is selected)
Parameters :
<State> 1 | ON | 0 | OFF

* RST : 0
Example :

SOURce : BB : ARBitrary : STATe ON

[:SOURce<hw>]:BB:ARBitrary:CLOCk <Clock>
User file mode sets the sampling rate.
Parameters :
<Clock> float

Value range: options
Step: 0.001
Default units: Hz
*RST: profile

Example :
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SOURce : BB : ARBitrary : CLOCk ?

[:SOURce<hw>]:BB:ARBitrar y:WAVeform:SELect <Filename>
Select an existing waveform file.
Parameters :
<Filename> string file name
Example :

SOURce:BB:ARBitrary:WAVeform:SELect D:\Assist\data\500_2 _MT.dat

SequenceMode:
[:SOURce<hw>]:BB:ARBitrary:WSEGment:CONFigure:SEL ect <Filename>
Select an existing sequence pattern waveform file.
Parameters :
<Filename> string file name
Example :

SOURce : BB : ARBitrary : WSEGment :
CONFigure : SELect D:\Assist\data\freq.seg

trigger:
[:SOURce<hw>]:BB:ARBitrary:TRIGger[:E XTernal]:INTerval <INTerval>
Automatic continuous triggering The time interval between the end of playing a
file and the next repeated playing of the file
Parameters :
< INTerval > float

Value range: 1E-9 - 10
Stepping: 1E-12
Default unit: s
*RST: 10E-6

Example :
:BB:ARBitrary:TRIGger: INTerval 1E-3

[:SOURce<hw>]:BB:ARBitrary:TRIGger[:EXT ernal]:TDELay <ExtTimeDelay>
Trigger delay
Parameters :
< ExtTimeDelay > fl oat

Value range: 600E-9 - 10
Stepping: 1E-12
Default unit: s
* RST : 600E-9

Example :



64

: BB : ARBitrary : TRIGger : TDELay 2E-3

[:SOURce<hw>]:BB:ARBitrary[:TRIGger] :SEQuence <Sequence>

Select the
trigger
mode
Parameter
s :
< Sequence > AUTO | SINGle

* RST : AUTO
Example :

:BB:ARBitrary:SEQuence SINGle

[:SOURce<hw>]:BB:ARBitrary :TRIGger:EXECute
Manual execution trigger

3.4 SOURce:BB:RADar Subsystem
The SOURce:BB:RADar subsystem is used to configure the generation of radar signals.

[:SOURce<hw>]:BB: RADar :STATe <State>
Play/Stop Radar
Parameters :
<State> 1 | ON | 0 | OFF

* RST : 0
Example :

SOURce:BB:RADar:STATe ON

[:SOURce<hw>]:BB:RADar:S HAPe <SHAPe>
Radar mode settings transmit waveform.
Parameters :
<SHAPe> Linear FM| Rectangular| Phase Coded| FM CW

* RST : Linear FM
Example :

BB:RADar:SHAPe Recta ngular

[:SOURce<hw>]:BB:RADar:PRI <Pri>
Radar mode sets the pulse repetition interval.
Parameters :
< Pri > float

Value range: 20ns ~ 50ms
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Stepping: 1ns
Default unit: s
*RST: 100us

Example :
BB:RADar:PRI 20E-9
BB:RADar:PRI 20ns

[:SOURce<hw>]:BB:RADar:PWID th <Width>
Radar mode sets pulse width.
Parameters :
<Width> float

Value range: 20ns ~ 50ms
Stepping: 1ns
Default unit: s
* RST : 50 us

Example :
BB:RADar:PWIDth 20e-9
BB:RADar:PWIDth 20ns

[:SOURce<hw>]:BB:RADar:SWID th <SWIDth>
Radar LFM and FMCWmodes set scan bandwidth .
Parameters :
<SWIDth> float

Value range: ≥ 100kHz The upper limit depends on the
hardware configuration and "S weep Interval" parameter,
For example, in the 1G bandwidth vector source, set "Sweep
Interval" parameter is Symmetric ,That Then themaximum
scanning bandwidth is 1G;
If the 1Gbandwidth vector source is set to "Sweep The
"Interval" parameter is Positive,That Then the
maximum scanning bandwidth is 500M.
Stepping: 1
Default units: Hz
* RST : 200e3

Example :
BB:RADar:SWIDth 400MHz

[:SOURce<hw>]:BB:RADar:SDURation <Duration>
Radar FMCWmode sets the scan time.
Parameters :
<Duration> float

Value range: ≥ 1ns
*RST: 10us
Stepping: 1ns
Default unit: s
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Example :
BB:RADar:SDURation 100ns

[:SOURce<hw>]:BB:RA Dar:SINTerval <Interval>
Radar LFM and FMCWmode settings scan range .
Parameters :
<Interval> Positive|Symmetric

*RST: Positive
Example :

BB:RADar:SINTerval Symmetric

[:SOURce<hw>]:BB:RADar:CODE <Co de>
Radar Phase Coded mode sets the encoding type.
Parameters :
<Code> Barker|Frank|P1|P2|PX|P3|P4|Taylor_QuadriPhase

* RST : Barker
Example :

BB:RADar:Code P1

[:SOURce<hw>]:BB:RADar:CWIDth <Width>​
Radar Phase Coded mode sets chip width.
Parameters :
<Width> float

Value range: ≥ 1ns
Default unit: s
*RST: 10us

Example :
BB:RADar:CWIDth
5us Set the chip
width to 5us

[:SOURce<hw>]:BB:RADar:BARKer <Number>

Radar Phase Coded Mode Setting BARKer Coding Type Number of Chips.
Parameters :
<Number> 2|3|4|5|7|11|13

* RST : 2
Example :

BB : RADar : BARKer 5

[:SOURce<hw>]:BB:RADar:QUARd <Number>
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Radar Phase Coded mode setting TAYLOR four-phase coding type chip number.
Parameters :
<Number> 13|25|27 |28A|28B

*RST: 13
Example :

BB:RADar:QUARd 25

[:SOURce<hw>]:BB:RADar:CNUMber <Number>​

Radar Phase Coded mode sets the number
of chips for other coding types.
Parameters :
<Number> integer

Value range: 0-10000
* RST : 4

Example :
BB:RADar:CNUMer 100

3.5 SOURce:BB:OFDM Subsystem
SOURce:BB:OFDM subsystem is used to configure the generation of OFDM signals
[:SOURce<hw>]:BB:OFDM:NSUBcarriers <NoOfSubCarr>
Set the number of available subcarriers for OFDM
Parameters :
<NoOfSubCarr> integer

Value range: 64 to 16384
* RST : 64

Example :
SOURce1:BB:OFDM:NSUBcarriers 256

[:SOURce<hw>]:BB:OFDM:NOCCupied <NumOccSc>
Set the number of occupied subcarriers
Parameters :
<NumOccSc> integer

Value range: 1 to 13107
* RST : 53

Example:
SOURce1:BB:OFDM:NOCCupied 202

[:SOURce<hw>]:BB:OFDM:SCSPace <SubCarSp>
Set the subcarrier frequency spacing
Parameters :
<SubCarSp> float

Value range: 1e3 to 2e6
Stepping: 1
*RST: 0.3125
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Default units: Hz
Example:

SOURce1:BB:OFDM:SCSPace 15kHz

[:SOURce<hw>]:BB:OFDM: SEQLength <SeqLen>
Set the number of OFDM symbol sequences
Parameters :
<SeqLen> integer

Value range: 1 to 1000
*RST: 10

Example:
SOURce1:BB:OFDM:SEQ Length 20

[:SOURce<hw>]:BB:OFDM:CPLength <CpLength>
Set the prefix length , themaximum prefix length is the number of subcarriers
Parameters :
<CpLength> integer

Value range: 0 to depends on settings
*RST: 16

Example:
SOURce1:BB:OFDM:CPLength 18

[:SOURce<hw>]:BB:OFDM:ALLoc<ch0>:MODulation <BaseModType>

Set the modulation mode
Parameters:
<BaseModType> BPSK | QPSK | QAM16 | QAM64 | QAM256

*RST: QPSK
Example:

SOURce1:BB:OFDM:ALLoc1:MODulation QAM256

[:SOURce<hw>]:BB:OFDM:DCMode <DCMode>
Sets the DC Subcarrier mode.
Parameters :
<DCMode> UTIL | PUNC

UTIL: All symbol assignments use the DC subcarrier to transmit
data
PUNC：DC subcarrier uses 0 Placeholder
*RST: UTIL

Example:
SOURce1: BB:OFDM:DCM ode PUNC

3.6 SOURce:BB:MCCW Subsystem
SOURce:BB:MCCW subsystem is used to configure the generation of multi-tone
signals
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[:SOURce<hw>]:BB: MCCW:STATe <State>
Play/Stop polyphonic
Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
Example:

SOURce:BB:MCCW:STATe ON

[:SOURce<hw>]:BB:MCCW:CARRier:COUNt <Count>
Set the number of available subcarriers for MCCW
Parameters :
<Count> integer

Value range: 1 to 8192
*RST: 10

Example :
SOURce1:BB:MCCW:CARRier:COUNt 64

[:SOURce<hw>]:BB:MCCW:CARRier: SPACing <Spacing>
Set the subcarrier frequency spacing
Parameters :
<Spacing> float

Value range: 100e3 to 100e6
Step: 0.01
*RST: 10e6
Default units: Hz

Example:
SOURce1:BB:MCCW:CARRier:SPACing 20e6

[:SOURce<hw>]:BB:MCCW:CLOCk <Clock>
Setting the Sample Rate
Parameters :
<Clock> float

Value range: 100e6 to 1.4e9
Step: 0.01
*RST: 1e9
Default units: Hz

Example:
SOURce1:BB:MCCW:CLOC k 150e6

[:SOURce<hw>]:BB:MCCW:RANDomphase <Randomphase>

Set whether to enable random phase
Parameters :
<Randomphase> 1 | ON | 0 | OFF
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* RST : 0
Example:

SOURce1:BB:MCCW:RANDomphase ON

Enable random phase

3.7 SOURce Analog Modulation Subsystem
The analog modulation subsystem is used to configure the generation of analog signals

[:SOURce<hw>]:LFOutput<ch>:FREQuency <Frequency>
Setting the frequency
Parameters :
< Frequency > float

Value range: 1e3 to installed options
Stepping: 1
*RST:
0.3125
Default
units: Hz

Example:
SOURce1:LFOutput:FREQuency 15kHz

[:SOURce<hw>]:LFOutput<ch>:SHAPe <Shape>
Setting the Waveform
Parameters :
<Shape > SINE | SQUare | TRIangle | Sawtooth | INV.Sawtooth

*RST: SINE
Example:

SOURce1:LFOutput: SHAPe 1
Set to rectangular wave

[:SOURce<hw>]:AM<ch>[:DEPTh] <Depth>
Setting AMmodulation depth
Parameters :
<Depth > float

Value range: 0-100
Example:

SOURce1:AM:DEPTh 50

Set AMmodulation depth to 50%
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[:SOURce<hw>]:FM<ch>[:DEViation] <Deviation>
Set FMmodulation depth
Parameters :
<Depth > float

Value range: 0- max
Default units: Hz

Example:

SOURce1:FM: DEVIATION​ 500KHz

Set FMmodulation depth to 500KHz

[:SOURce]:PM<ch>[:DEViation] <Deviation>
Setting PMmodulation depth
Parameters :
<Depth > float

Value range: -10- 10
Default unit: deg

Example:

SOURce1:PM: DEViation 10

Set PMmodulation depth to 10 degrees

3.8 SOURce:BB:HOPPing Subsystem
SOURce:BB:Hopping subsystem is used to configure the generation of frequency
hopping signals

[:SOURce<hw>]:BB:Hopping:STATe <State>
Play/Stop frequency hopping
Parameters :
<State> 1 | ON | 0 | OFF

* RST : 0
Example :

SOURce:BB:Hopping:ST ATe ON

[:SOURce<hw>]:BB:Ho pping:CARRier:COUNt <Count>
Set the number of available subcarriers
Parameters :
<Count> integer

Value range: 1 to 8192
*RST: 10

Example :
SOURce1:BB:Hopping:CA RRier:COUNt 64
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[:SOURce<hw>]:BB:Hopping:CARR ier:SPACing <Spacing>
Set the subcarrier frequency spacing
Parameters :
<Spacing> float

Value range: 0 to 1e9
Step: 0.01
*RST: profile
Default units: Hz

Example:
SOURce1:BB:Hopping:CARRier:SPACing 20e6

[:SOURce<hw>]:BB:Hopping:CLOCk <Clock>
Setting the Sample Rate
Parameters :
<Clock> float

Value range: 700 to 1.4e9
Step: 0.01
*RST: profile
Default units: Hz

Example:
SOURce1:BB:Hopping:CLOCk 150e6

[:SOURce<hw>]:BB:Hopping:MODE <MOD E>

Set the pattern to a pseudo-random sequence or user-specified
Parameters :
< MODE > RANDom | TABLe

*RST: RANDom
Example:

SOURce1:BB:Hopping:MODE TABLe

Enable user-specified mode

[:SOURce<hw>]:BB:Hopping:PRBS <LENGth>

Set the length of the pseudo-random sequence
Parameters :
< LENGth > 7 | 9 | 11 | 12 | 15 | 16 | 20 | 21

*RST: 12
Example:

SOURce1:BB:Hopping:PRBS 7

Set the length of the pseudo-random sequence PRBS7
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3.9 SOURce:NOISe Subsystem
SOURce:NOISe subsystem is used to generate random Gaussian white noise

[:SOURce<hw>]:NOISe:BWIDth <bandwidth>

Set the bandwidth of Gaussian white noise
Parameters :
< bandwidth > Bandwidth

Default Units : Hz
*RST: 10MHz

Example:

:SOURce:NOISe:BWIDth 1e9

Set the Gaussian white noise bandwidth to 1 GHz

[:SOURce<hw>]:NOISe:D URation <duration>

Set the duration of Gaussian white noise
Parameters :
< duration > Duration

* RST : 5 ms
Example:

:SOURce:NOISe: DURAT 5e-3

Set the Gaussian white noise duration to
5ms
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4. MMEMory Subsystem
MMEMory subsystem (Mass Memory) is used to load data into the internal files of the instrument.

:MMEMory:DATA <Filename>, <BinaryBlock>
Write the block data <BinaryBlock> to the file named by <Filename>
Parameters :
<Filename> string file name

If Filename is not an absolute path, the path is in D:\ waveform

<BinaryBlock>
#<number><length_entry><data>
<number>: Indicates the decimal length of
<length_entry> (1 decimal digit The value range is 1-9)
<length_entry>: Data body length, in bytes
<data>: Data body

Example :
:MMEMory:DATA "D:\waveform\1.bin", # 215hellohellohello
2 means <length_entry> is 2 decimal digits; 15means the
data body <data> It consists of 15 bytes.
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5. Pulse modulation subsystem
SOURce:PULM subsystem is used to generate pulse modulation

[:SOURce<hw>]:PULM:STATe <State>
Set the pulse output switch
< State > Pulse status

0 | off: turn off the output
1 | on: turn

onoutput Example:

: PULM:STATe 1
Set the pulse to output state

[:SOURce<hw>]:PULM:Gen <Gen>
Set the pulse output switch
< Gen > Pulsemodulation status

0 | off: turn off the output
1 | on: turn

onoutput Example:

:
PULM:Gen
1 Turn on
pulse
modulation

[:SOURce<hw>]:PULM:PERiod <Period>​

Set the pulse period
Parameters :
< Period > Pulseperiod

Value range: 10E-6 - 50
Stepping: 1E-12
Default unit: s
* RST : 20E-9

Example:

SOURce:PULM:PERiod
10e-6 Set the pulse
period to 10us

[:SOURce<hw>]:PULM:WIDth <Period>

Setting the Pulse Width
Parameters :
< Period > PulseWidth

Value range: 10E-6 - 50
Stepping: 1E-12
Default unit: s
* RST : 20E-9

Example:

SOURce:PULM:WIDth 8e-6

Set the pulse width to 8us



[:SOURce<hw>]:PULM: SOURce <Source>

Set internal and external trigger

Parameters :
< Source > Internal andexternal triggers

Internel: Internal trigger
Externel: External trigger

Example:

SOURce:PULM:SOURce Internel

Set internal trigger
[:SOURce<hw>]:PULM:TRIGger:SOURce <Source>

Setting Trigger

Internal and
external triggers
Parameters :
< Source > tigger Internal and external triggers

Internel Trigger: tigger Internal trigger
External Trigger: tigger external trigger

Example:

SOURce:PULM:TRIGger:SOURce Internel
Trigger Setting up tigger Internal trigger

[:SOURce<hw>]:PULM:TRIGger:SYNCh <Synch>

Set the trigger synchronization mode
Parameters :
< Synch > Set trigger to synchronous or asynchronous

Synchronous: Trigger synchronization
Non-synchronous: Trigger asynchronously

Example:

SOURce:PULM:TRIGger:SYNCh Synchronous Set
trigger to trigger synchronization

[:SOURce<hw>]:PULM:TRIGger:SYNCh:DELay < Delay >

Set the trigger edge

Parameters :

< Delay > Synchronous trigger delay



Value range: 10E-6 - 50
Stepping: 1E-12
Default unit: s
* RST : 20E-9

Example:

SOURce : PULM : TRIGger : SYNCh :DELay 8e-6

set 8us Synchronization delay

[:SOURce<hw>]:PULM:TRIGger:EDG E < Edge>

Set the trigger
edge Parameters :
<Edge> Postive : rising edge trigger

Negative: Falling edge trigger
Example:

SOURce:PULM:TRIGger:EDGE Postive
Set to rising edge trigger

[:SOURce<hw>]:PULM:TRIGger: MODE <Mode>

Set the
trigger
mode
Parameter
s :
<Mode> Single: Single trigger

Pulse-train: Pulse train trigger
Example:

SOURce:PULM:TRIGger:Mode
Single Set to single trigger

[:SOURce<hw>]:PULM:TRAIn:NUMBer < NUMBer >

Set the
trigger
mode
Parameter
s :
< NUMBer > integer

Value range: 1 to 65535
*RST: 10

Example:

SOURce:PULM:TRAIn:NUMBe
r 100 Set pulse train to 100

[:SOURce<hw>]:PULM:TRAIn:PERiod < PERiod >

Set the
trigger
mode
Parameter
s :
< PERiod > integer

Value range: 1 to 65535
*RST: 10

Example:

SOURce:PULM:TRAIn:PERiod



200 Set the pulse train
period to 200
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